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 Requirements 1.
You will need Adobe Premiere Pro CC 2015.3 or later. 
You will need the latest Tangent Hub. 

 Quick Start 2.
1. Install Premiere Pro. 
2. Install the Tangent Hub. 
3. Plug in the Element panels. 
4. Start Premiere Pro. 
5. Create a new project. 
6. In Premiere Pro preferences set Tangent as the control surface type. 
7. Load a clip into the Premiere Pro timeline. 
8. Click on Color in the workspace switcher to open the Lumetri Color Panel. 
9. Now click on one of the Lumetri Color Panel sections. 

What functions the Element panels control will change depending on what section of 
the Lumetri Color Panel is open. 
 

The rest of this document explains the above steps in more details.  
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 Configuring Premiere Pro to use the Element panel 3.
1. Make sure you have Premiere Pro CC 2015.3 or greater installed. 

 
2. Download and install the latest Tangent Hub package from our website: 

www.tangentwave.co.uk/support 
 

3. Connect the Element panels, using a powered USB hub if necessary. 
 

4. Run Premiere and open the Preferences -> Control Surfaces… dialog. 
 In Windows this is under the Edit  menu. 
 In Mac this is under the Premier Pro CC  menu. 

 

 
 
  



����������������������������� �������	�
����
����
���

����	�
����
����
���

����	�
����
����
���

����	�
����
����
���

� ������ ��
��
����
��
����
��
����
��
��� ����
 

 
 

''' '

5. Click Add  and select Tangent  as the Device Class. 
 

 
 

6. Click OK to shut this dialog, and click OK to shut the Preferences dialog. 
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 The basic idea 4.

4.1 Element panel controls 
This document assumes you have at least one of each Element panel type 
connected. You can of course use any combination of panels and add more of a 
particular panel type if you like. 
 
Let’s start by familiarising ourselves with the controls on the panels. 
 
Displays 

Each panel has a display. The display is used to label what the controls do. 
 
In the case of the buttons and knobs on the Kb and Bt panel, the display is 
split into a grid of 12 cells, with each cell representing a control. The cell 
position of the display matches the control position on the panel. The same 
applies to the group of 12 buttons on the Mf panel. 

 
Buttons 

You can program the buttons to do anything that Premiere allows. You can 
even assign keyboard short-cuts to them. Some buttons have legends on 
them to help identify them, but you can still choose what you want them to do. 

 
The only two buttons that are different and cannot be programmed are the 
resets for the trackerballs and rings. See the Trackerball and Ring  below. 

 
Knobs 

You can program the knobs to do anything that Premiere allows. You can 
even assign keyboard short-cuts to them, triggering a different keyboard short-
cut depending on the direction of rotation. 

 
The only thing to note with a knob is that if you press down lightly on a knob it 
will reset its value. You cannot program this reset to do anything other than 
reset the knob value. 

 
Trackerball and Ring 

 
The trackerball and ring each have their own reset: 

 

This resets the trackerball. 

 

This resets the ring. 
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You can program the trackerball and ring to do anything that Premiere allows. 
You can even assign keyboard short-cuts to them, triggering a different 
keyboard short-cut depending on the direction of rotation. 
 
With the trackerball it’s possible to assign a different control to each axis.  
 

Adobe provide a default map for Premiere Pro, and what the controls do changes 
depending on what mode Premiere Pro is in. You can use the Tangent Mapper to 
create your own map and customise what the controls. We’ll cover this later, but for 
now just use the default map provided when you install the Tangent Hub and 
Premiere Pro. 
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4.2 Lumetri Color Panel in Premiere Pro 
In Premiere Pro you have the Lumetri Control Panel. In the screen shot below, we 
have loaded a clip into Premiere Pro and clicked on Color  in the workspace 
switcher bar at the top of the screen. This gives us the Lumetri Color Panel  on the 
right of the screen. 
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4.3 How the Elements interact with the Lumetri Colo r Panel 
In the Lumetri Color Panel you will see the following sections: 

·  Basic Correction 
·  Creative 
·  Curves 
·  Color Wheels 
·  HSL Secondary 
·  Vignette 

 
As you click on the sections it opens to show the controls that are available for that 
section. What the Element panels control is switched automatically to match the 
current Lumteri Color Panel section that’s open. 
 
Rather than use the mouse to open the various sections in Lumetri, you can do this 
from the Mf panel. So let’s do this now: 
 
On the Mf panel, press the button labelled WS:Color . This is the same as using 
the mouse to click on Color  in the workspace switcher bar at the top of the screen. 
This will open the Lumetri Color Panel. 
 
Now on the Mf panel press the button labelled Wheels . This is the same as using 
the mouse to click on the Color Wheels  in the Lumetri Color Panel. This will open 
the Color Wheels section. 
 
Now on the Mf panel press the buttons labelled Basic, Creative, Curves, HSL and 
Vignette. As you do this, you will see the displays on the Element panels update to 
show you what they’re controlling in each of the sections. 
 
Note the top line of the display on the Tk panel will tell you what mode you’re in. 
 
One final thing to note is that if on the Mf panel you press WS:Editing  Premiere 
will change workspace to Editing. 
 
There is a table of Element / Premiere Pro panel mapping at the end of this 
document. Take a quick look at the table before continuing on to the next section 
where we are going to look at a couple of control examples. 
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 Taking a look at how the controls work 5.
If you haven’t done so, load a clip into your timeline, and press the WS:Color  button 
followed by the Wheels  button on the Mf panel. You should see the following in the 
Premiere Pro Lumetri Control Panel: 
 

 
 
Now take a look at the Element / Premiere Pro mapping table  at the end of this 
document. The mapping table for Lumetri - Color Wheels  says that the Tk panel will 
do the following: 
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Let’s start by looking at the mapping for the middle trackerball and ring. Both the ring 
and the trackerball are mapped to control Midtones . 
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5.1 Trackerball 
Gently roll the middle trackerball of the Tk panel diagonally towards you and left. 
You will see the Midtones Color Wheel move towards green. Basically, move the 
ball in the direction of the color on the Color Wheel to change the picture tint 
towards that color. 
 

 
 
Now press the trackerball reset button above the middle trackerball and ring. This 
will reset the midtones color wheel control back to the centre.  

 

 

This resets the trackerball. 
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5.2 Ring 
Now rotate the middle ring in a clockwise direction. You will see the Midtones 
luminance slider move up. Basically, move a ring clockwise and its control will 
increase, move it anti-clockwise and it will decrease.  
 

 
 
Now press the ring reset button above the middle trackerball and ring. This will 
reset the midtones luminance slider control back to the centre.  
 

 

This resets the ring. 
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5.3 Standard and Alternate mapping 
Controls may have an alternative function assigned to them. Think of this like 
pressing the ‘shift’ key on your keyboard. The functions don’t have to be related. To 
access the alternative functions you press a button that has been programmed to 
be Select ALTernative Function . 
 
Let’s look at an example: select the Lumetri Basic in Premiere Pro, you can do this 
by first pressing the WS:Color  button on the Mf panel to select the color 
workspace, and then pressing the Basic  button on the Mf panel. 
 
Take a look at the Bt control map for the Lumteri – Basic , you’ll find this in the 
Element / Premiere Pro mapping table  section. It shows the following: 
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Now look at the display on the Bt panel, you’ll see it matches the labels in the white 
boxes of the table above. These are the Standard  mappings for the buttons. 
 
Now press and hold the ‘A’ button on the Bt panel. The display on the Bt panel will 
change to match the labels in the grey boxes of the table above. These are the 
Alternate  mappings for the buttons. Why has this happened? Well, in the table 
above you can see that the ‘A’ button is mapped to be Select ALT  which is short 
for Select ALTernative Function . 
 
So, if you just press the top left button on the BT panel you will get the Prev LUT  
(previous LUT). But, if you press and hold the ‘A’ button and press the top left 
button you will get Copy . 
 
This principle of Standard  and Alternate  mapping also applies to knobs, 
trackerballs, and rings.  
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5.4 Banks 
One last thing to understand about how the controls are mapped is the concept of 
Banks . To explain what a Bank  is let’s take the example of the Kb panel. The Kb 
panel has 12 knobs, but what if you have more than 12 things you want to control 
with a knob? A Bank  lets you do just that – it’s another page of controls you can 
switch the panel to by pressing a button. 
 
Select the Lumetri HSL Secondary in Premiere Pro, you can do this by first 
pressing the WS:Color button on the Mf panel to select the color workspace, and 
then pressing the HSL button  on the Mf panel. 
 
Take a look at the Kb control map for the Lumteri – HSL Secondary , you’ll find 
this in the Element / Premiere Pro mapping table  section. It shows the following: 
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You can see there are two Banks : Bank 1 and Bank 2. 
 
Ignore the grey boxes in the table and just look at the labels in the white boxes. 
You can see that the ‘B’ button is mapped to be Next Knob Bank . Press the ‘B’ 
button and you will see the labels on the Kb panel display switch between the 
labels in the white boxes in Bank 1 and Bank 2 of the table above. What’s 
happening is that you’re switching between Banks , and so the knobs will switch to 
controlling different functions. 
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Note that the top line of the Tk display will tell which bank you’re in. 
 
Don’t get confused between Banks  and Alternate  functions. 
 
It’s worth noting that it is possible to have as many banks as you want. 
 
This principle of Banks  also applies to buttons, trackerballs and rings. 
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 Control sensitivities 6.
If you want the trackerballs, rings or knobs to be more or less sensitive (move their 
control more or less for a given movement) then go to the Tangent Mapper and open 
the File -> Control Map Settings…  menu. You should now get a pop-up window like 
this: 
 

 
 
Set the sensitivity to suit how you want the control to respond: 

·  fine  means you have to move the control further to get a change. 
·  coarse  means you will need to move the control less to get a change. 

 
These settings apply globally to all controls of that type on the panel. If you wish to 
change the sensitivity for just a certain control in Premier Pro then you can do this by 
going to that control in the Mapper. We discuss this in the Customising the Element 
control map  section. 

 
Going back to what we said earlier about Standard  and Alternate  mapping, you can 
see that each has its own set of sensitivities. 
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 Customising the Element control map 7.
Read the Mapper manual before you attempt any of the following! We are going to be 
using modes  a lot in our discussion of customising, so understand what a mode  in the 
Mapper is. 
 
Make sure you have Premiere Pro running and run the Tangent Mapper which you will 
find in the Tangent applications folder. 
 
In the Mapper you will see a row of tabs that correspond to the different panel types from 
Tangent. Select the appropriate Element panel tab. 
 

 
 
Across the top of the Mapper window you will see all the modes  that Adobe have 
defined for Premiere Pro in the Mapper: 

·  Editing 
·  Lumetri - Basics 
·  Lumetri - Creative 
·  Lumetri - Curves 
·  Lumetri - Color Wheels 
·  Lumetri - HSL 
·  Lumetri - Vignette 

 
The Lumetri modes  in the Mapper correspond to the various sections in the Lumetri 
window in Premiere Pro. Think of a mode in the Mapper as being a section in the Lumetri 
window. The only exception here is the Editing mode which Adobe have defined to cover 
the Editing workspace. 
 
As you click through the modes in the Mapper, you will see that some modes have 
different mappings for the controls on the Element panels. This means, when you’re in 
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Premiere Pro, and you’ve selected a Lumteri mode, the Element panels will have their 
controls mapped as specified for that mode in the Mapper. 

 

7.1 Steps to customise a control (a brief introduct ion) 
1. Select the mode in the mapper. 

Select the correct Lumetri mode in the Mapper by clicking on its tab. This is 
important as the control you are changing will only appear when that section is 
selected in the Premiere Pro Lumetri window. 
 

2. Left click on the control in the mapper. 
Left click on the control you wish to customise in the Mapper – this can be a 
trackerball / ring, a knob or a button. This will open the Control Mapping 
window. 
 

 
 
With a trackerball / ring you can select a combined  mapping which is a control 
that maps to both the ring and trackerball – a color wheel is a good example of 
this where the ball trackerball controls the color differential and the ring controls 
the luminance. Or you can assign individual controls to just the individual 
trackerball axis and ring. 
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3. Assign a control to the Standard Mapping. 
In the above example we have clicked on the right trackerball. Under Standard 
Mapping we can see it says Highlights , if you click on this it will pop-up a 
menu that allows you to reassign what the control does. 
 

4. Assign a control to the Alternate Mapping (if yo u want to). 
In the above example you will see that under Alternate Mapping it says No   
Combined Mapping  we can assign a control that the panel will switch to when 
the a button mapped to be Select ALTernative Function  is pressed and held. 
 

5. Save the changes to your map. 
Note any changes you make are “live”, this means they take effect as soon as 
you make them in the Mapper. However, you still need to save the changes in 
the Mapper if you wish to keep them. You cannot overwrite the default file 
supplied with Premier Pro, so you will have to save the changes in your own 
map. 
 

7.2 Global sensitivity flag 
Note with the trackerballs, rings and knobs you can set the sensitivity of the control. 
If the Global  box is ticked it means the control will use the global sensitivity 
assigned for all controls of that type (see Control Map Settings…  menu). 

 

7.3 A suggested use for Standard and Alternate mapp ing 
Say you often find yourself wishing that sometimes the trackerballs would be more 
responsive when you want to quickly change to a color. What you can do is assign 
a fine  sensitivity to the Standard Mapping , meaning you will be able to make 
more subtle adjustments. Then in the Alternate Mapping  set the sensitivity to 
coarse . Now if you press and hold Select ALTernative Function , the trackerball 
will move much quicker, and when you get close to the color you want release the 
Select ALTernative Function  to fine tune your adjustment. 
 
Make sure you remember in this example to assign the same control to both the 
Standard and Alternate mapping (for example, both need to be Highlights). 
 
And don’t forget to assign Select ALTernative Function  to a button. 
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7.4 Help – I’ve screwed my mapping up! 
If you get stuck and want to go back to the default you can do either of the 
following: 
 

·  Reload the default map.  
In the Mapper go to the File -> Manage Control Maps…  menu. 

 
Or… 
 

·  Reset everything to factory defaults. 
In the Mapper go the Help -> Reset System  menu. Note that choosing the 
Reset System option will delete all Mapper user data (maps and 
preferences you have created) for all applications supported by the 
Mapper and not just Premiere Pro. 

 

 Element / Premiere Pro mapping table 8.
 
The following sections show the panel mapping for each of the “modes” that Adobe have 
defined for Premiere. You can change this mapping to suit your own way of working using 
the Tangent Mapper. 
 
In the table the grey cells indicate the alternative mapping that the control will do when you 
press any button that has been mapped to Select ALTernative . 
 
Standard  
Alternative  
 
Note that the controls on some panels have more than one bank . You can select the next 
bank of controls by pressing any button that is mapped to be Next Button Bank  or 
Previous Button Bank . There is also a previous and next bank button for knobs and 
trackerballs.  
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8.1 Editing 
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8.2 Lumetri – Basic 
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8.3 Lumetri – Creative 
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8.4 Lumetri – Curves 
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8.5 Lumetri – Color Wheels 
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8.6 Lumetri – HSL Secondary 
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8.7 Lumetri – Vignette 
 
Bt panel 
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Kb panel 
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Tk panel 
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